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PERIODE 1 

 

Activité 1 

 

Nom de l’activité: Lire un article de recherche qualitative 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Se familiariser avec la lecture/rédaction d’un article de recherche qualitative et les critères 

d’évaluation. 

Objectifs d’apprentissage : 

L’apprenant sera capable:  

- d'identifier les différentes parties d’un article de recherche qualitative (problématique, cadre 

conceptuel ; question de recherche ; recueil et analyse de données; résultats et discussion) 

- d’identifier et de commencer à appliquer les critères d’évaluation, utilisés par les revues de 

recherche qualitative, pour évaluer un article 

- de rédiger un rapport réflexif. 

Motivation de l’enseignante: Se familiariser avec la démarche de la recherche qualitative en lisant 

l’article produit par les étudiants MALTT de la volée VOLT. Lecture critique avec prise de connaissance 

des critères d’évaluation utilisés pour les articles qualitatifs. D’un point de vue contenu du projet, se 

familiariser avec la recherche sur laquelle les étudiants WALL-E vont travailler.  

Motivation pour les étudiants: Lire un article de manière critique (dans le rôle d’un chercheur) pour 

comprendre comment s’articule la recherche qualitative. Visualiser les liens entre les différentes 

parties (problématique, cadre conceptuel, question de recherche, méthodologie et résultats) et leur 

cohérence et se familiariser avec les critères d’évaluation d’un article qualitatif.  

Description de l’activité : 

Stratégie pédagogique : lecture active et critique 

Activité individuelle :  

 Depuis les ressources du cours,  téléchargez l’article suivant : 

P1_Act1_PistesReflexivesApprentissageMethodoRecherche  

 Depuis les ressources du cours, téléchargez les critères d’évaluation d’un article de recherche 

qualitative : Act1_CriteresEvaluationR-QUAL 

 Lisez l’article, et, à l’aide des critères d’évaluation, identifiez les éléments présents et leur 

pertinence et faites-vous une opinion quant à la qualité de l’article.  

 Attention ! Les activités 1 et 2 sont menées en parallèle sur deux semaines car l’une et l’autre 

sont liées. Vous allez sans doute devoir faire des allers-retours entre les différents documents 

de ces deux activités avant de remettre votre contribution pour l’une ou l’autre.   
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Ressources:  

 L’article : P1_Act1_PistesReflexivesApprentissageMethodoRecherche.pdf  

 Les critères d’évaluation d’un article de recherche qualitative : P1_Act1_CriteresEvaluationR-

QUAL.pdf 

Temps nécessaire: 3 h 

Résultat attendu: Une lecture attentive de l’article et le passage du test de lecture dans Moodle.  

Evaluation:  

Evaluation automatique : Test de lecture effectué dans Moodle, évalué de manière sommative, avec 

une note sur 6.  

En cas de remise en retard du travail, 1 point sera enlevé à la note finale, pour chaque semaine de 

retard.  

Début d’activité : 03-10-2016 

Fin d’activité : 18-10-2016 

Lieu de l’activité : Moodle  
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Activité 2 

 

Nom de l’activité: Travail sur les concepts et caractéristiques de la recherche qualitative 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Se familiariser avec les caractéristiques de la recherche qualitative.  

Objectifs d’apprentissage : 

L’apprenant sera capable d’identifier les caractéristiques de la recherche qualitative. 

Motivation de l’enseignante: C’est en partant de l’expérience du chercheur francophone amené à lire 

des textes scientifiques en anglais qu’est née l’idée de concevoir cette activité car elle vous amène à 

lire des extraits de texte en anglais et en français. Elle est également motivée par le vécu d’autres 

apprenants d’un cours de méthodologie rapportant avoir beaucoup appris des réponses de leurs pairs.  

Motivation pour les étudiants: Vous devrez sans doute lire des textes en français et en anglais lorsque 

vous ferez la revue de littérature de votre mémoire. Partir de sources dans deux langues différentes et 

réaliser un résumé pour synthétiser un concept est une activité couramment rencontrée durant la vie 

estudiantine. Vous allez devoir évaluer ce résumé, autrement dit une réponse donnée par un 

apprenant vous ayant précédé.  

Description de l’activité: 

Stratégie pédagogique : activation de savoirs en cours d’apprentissage par le passage d’une langue à 

l’autre et par l’évaluation d’un résumé.   

Activité individuelle :   

 Depuis les ressources du cours, télécharger le document « 21 questions pour travailler des 

concepts et caractéristiques de la recherche qualitative», qui comme son nom l’indique, 

comporte 21 questions relatives à la recherche qualitative et des extraits d’ouvrages 

scientifiques se rapportant aux concepts et caractéristiques abordés dans les questions. 

 Lisez l’entièreté du document.  

 Evaluez le résumé qui vous a été attribué selon les 3 critères mentionnés dans les ressources 

et rédigez un rapport qui pourrait faire office de feedback formatif de 150 mots maximum.  

Ressources:  

- Document « 21 questions pour travailler des concepts et caractéristiques de la recherche 

qualitative» : P1_Act2_Caracteristiques_Recherche-Qualitative.pdf 

- Critères d’évaluation des résumés proposés : P1_Act2_CriteresEvaluationResume.pdf 

Temps nécessaire: 5h 

Résultat attendu:  

1) Un rapport d’évaluation, de 150 mots maximum, du résumé qui vous a été attribué. 

L’évaluation doit être insérée dans le wiki de l’activité 2, période 1 : 
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http://tecfalms.unige.ch/moodle/mod/wiki/view.php?id=16081  , sous la bonne question. 

Veillez aussi à ajouter vos nom et prénom en titre de votre évaluation.  

Evaluation:  

Evaluation formative : Feedback général, de la part de l’équipe enseignante, sur le forum, en reprenant 

les aspects spécifiques des évaluations et en élaborant dessus. Feedback remis au plus tard le 25-10-

2016.  

En cas de remise en retard du travail, l’étudiant ne se verra pas attribuer de feedback formatif et 1 

point sera enlevé à la note finale, pour chaque semaine de retard.  

Début d’activité : 03-10-2016 

Fin d’activité : 18-10-2016  

Lieu de l’activité : Moodle 

Activité transversale individuelle – suite aux activités 1 & 2 

Description :  

Rédigez un rapport réflexif, portant sur les activités 1 et 2. Le rapport peut être libre ou répondre aux 

questions ci-dessous ou adopter une approche mixte (500 mots maximum). Si vous n’avez jamais 

rédigé de rapport réflexif, vous pouvez lire l’article de Boud, D. (2001). Using journal writing to enhance 

reflective practice. In English, L. M. and Gillen, M.A. (Eds.) Promoting Journal Writing in Adult 

Education. New Directions in Adult and Continuing Education No. 90. San Francisco: Jossey-Bass, 9-18. 

(Dans les ressources du cours : Info_Boud2001_EcritureRapportReflexif.pdf)  

Questions guide :  

Avant de débuter l'activité: qu'attendez-vous de cette activité? Comment allez-vous vous organiser 

pour la mener à bien? Quels sont vos objectifs ? Qu’allez-vous mettre en œuvre pour les atteindre ? 

Pendant l'activité: rapportez ce que vous êtes en train d'apprendre et comment vous êtes en train 

d’apprendre, ce que vous comprenez bien et ce qui est plus difficile ou que vous ne comprenez pas 

et essayez de comprendre pourquoi.  

Après l'activité: qu'avez-vous appris de cette activité, en termes de contenu? Vous pouvez 

également mentionner ce que vous avez appris en terme d'organisation et de processus (e.g. ce 

que vous feriez différemment lorsque vous vous lancerez dans une activité d’apprentissage 

similaire la fois suivante).  

Ressources:  

- Article de Boud (2001) sur le rapport réflexif : Info_Boud2001_EcritureRapportReflexif.pdf 

Résultat attendu :  

Un rapport réflexif, sur l’activité 1 et 2 (500 mots maximum), qui peut aussi intégrer des 

représentations visuelles (schémas, cartes conceptuelles, etc.). Le rapport est à rédiger dans votre 

journal réflexif Moodle > Activité 1-2 : 

http://tecfalms.unige.ch/moodle/mod/wiki/view.php?id=15777 

Evaluation :  

Evaluation sommative : Note sur 6 pour le rapport réflexif basée sur le barème disponible sur 

Moodle : http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15765    

Temps nécessaire: 2h 

http://tecfalms.unige.ch/moodle/mod/wiki/view.php?id=16081
http://tecfalms.unige.ch/moodle/mod/wiki/view.php?id=15777
http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15765
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Activité 3 

 

Nom de l’activité: Début du travail sur le projet de recherche commun. Lecture approfondie d’un 

entretien et codage selon un codebook donné.   

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Se familiariser avec un entretien et le coder.   

Objectifs d’apprentissage : 

- Etre capable de coder un entretien en se basant sur un codebook donné ; 

- Etre capable d’utiliser un codebook et de le faire évoluer; 

- Etre capable d’utiliser un logiciel spécialisé de type Computer Assisted Qualitative Data 

Analysis Software (CAQDAS), en l’occurrence Atlas-ti. 

Motivation de l’enseignante: Débuter le travail d’analyse des entretiens par le codage. En effet, le 

codage, au-delà de son aspect technique de préparation des données, est déterminant pour la suite 

du travail et constitue déjà une analyse. N’hésitez pas à écrire tout ce qui vous vient à l’esprit durant 

cette phase du travail ! Cette activité permet également de s’imprégner de ses données.  

Motivation pour les étudiants: Apprendre en faisant avec du « vrai » et être responsable, face à ses 

propres contributions, et face à celles de ses pairs.  

Description de l’activité: 

Stratégie pédagogique : analyse  

Activité individuelle :  

 Depuis le dossier TéléchargementProjet sur Moodle, téléchargez les 8 entretiens et lisez-les. 

Téléchargez également les fiches de contact et lisez-les. 

 Appropriez-vous l’entretien traité par votre groupe en le lisant attentivement. Deux à trois 

étudiants travailleront sur le même entretien. L’entretien vous sera attribué et la constitution 

des groupes se fera durant le présentiel du 27 septembre. Notez que les groupes formés 

resteront identiques pour le restant du cours.  

 Depuis le dossier TéléchargementProjet, téléchargez le fichier P1_Act3_Codebook.xml et 

importez-le dans Atlas ainsi que le fichier pdf de l’entretien dont votre groupe est responsable. 

Sauvegardez le projet comme une Hermeneutic Unit (Fichier > Enregistrez sous) puis Project > 

Add documents pour ajouter votre entretien puis Project > Import > Codes > xml > 

Codebook.xml. Donnez un nom explicite à votre projet ! Ex : 

Groupe1_EntretienEtu3_VotrePrenom. (Pour un groupe, il y aura donc deux ou trois 

Hermeneutic Unit avec des noms différents puisque vous ajoutez votre prénom). 

 Codez l’entretien individuellement en reprenant le fichier codebook.xml. Ce codebook est 

celui de l’article donné en lecture de l’Activité 1 mais utilise uniquement les codes suivants : 

APP_Pairs, APP_RéinvestissementProjPersonnel ainsi que tous les codes des catégories 

suivantes : Concepts difficiles, Conception de la recherche, Attributs.  
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 Téléversez, dans le dossier Moodle intitulé P1 Act 3 Productions Etudiants votre HU sauvegardé 

sous forme de copy bundle (Project > Save copy bundle).  

 Si vous le souhaitez, rédigez un rapport réflexif libre.  

Réglages préalables  

La gestion d’un projet de codage de groupe nécessite une grande discipline. Vous voudrez bien 

effectuer les vérifications et réglages suivants et télécharger les fichiers à coder selon la procédure 

indiquée :  

- Vérifiez que la langue du logiciel Atlas-ti soit bien positionnée sur français (p. 66 du manuel 

Atlas). A priori, Atlas détecte la langue de votre ordinateur et se synchronise dessus.  

- Ajouter votre nom dans les utilisateurs Atlas pour que votre codage porte votre nom. Pour ce 

faire, suivez les instructions du manuel pp. 147-150. En résumé, il faut ouvrir Atlas-ti en mode 

administrateur (clic droit sur Atlas-ti depuis le menu démarrer) puis aller dans Tools > User 

Management > User Editor > Edit > New User puis ajouter votre nom. Lorsque vous attribuez 

votre premier code, mettez votre souris sur le code dans la marge et vérifiez que c’est bien 

votre nom qui apparait et non Super ou autre.  

Coder  

- Coder, c’est attribuer un code à une unité de sens pour résumer des segments de données et 

c'est déjà une forme d’analyse précoce (pas uniquement une organisation des données en vue 

de l’analyse).  

- En vous basant sur le codebook, vous allez attribuer, de manière systématique, des codes aux 

différents passages des entretiens. Un passage peut être codé à l’aide de différents codes. 

Tous les passages d’un entretien ne sont pas forcément codés.  

- Attention, lorsque vous rajoutez un code, veillez à respecter la structure du codebook : vous 

vous souvenez qu’un codebook doit être un tout cohérent. Il est donc possible et normal 

d’ajouter (ou supprimer) des codes, mais ces derniers doivent être en relation, 

conceptuellement, avec le codebook crée initialement.  

 

D’un point de vue technique, la barre d’outils utile pour le codage, dans Atlas, se trouve sur la 
gauche. Vous sélectionnez un passage de votre entretien et cliquez sur le losange jaune avec 
du texte sur la droite, ce qui vous permet de choisir le code approprié depuis le codebook. Une 
fois sélectionné, vous le voyez apparaître dans la marge de votre entretien. Ce texte codé 
devient une « quotation » dans le langage Atlas. Si vous souhaitez effacer une citation, vous 
pouvez vous positionner dessus ou sur son code et, à l’aide d’un clic droit, sélectionner 
« delete ».   
Vous pouvez regarder le tutoriel de 6mn expliquant le codage de texte : 
https://www.youtube.com/watch?v=NouyHaWGszA&list=PL8CTEdsSSmZG7znMUsXLekGikQY
rPB-v5&index=12  

 Pour avoir accès à tous les codes, vérifier la catégorie à laquelle ils appartiennent et leur 
définition, vous pouvez accéder au « codes manager », soit depuis le menu tout en haut Codes 
> Codes manager, soit depuis le bouton « Codes », en haut de votre transcription.  
Vous pouvez regarder le tutoriel de 3mn expliquant les fonctionnalités du code manager  : 
https://www.youtube.com/watch?v=jMnz7Tqoz28&index=10&list=PL8CTEdsSSmZG7znMUsX
LekGikQYrPB-v5  

 

- Durant cette opération de codage, si des idées d’interprétation et d’analyse vous viennent à 

l’esprit, vous pouvez utiliser la fonction memo (p. 243 et suivantes du manuel Atlas) ou un 

simple bloc-notes.  

https://www.youtube.com/watch?v=NouyHaWGszA&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-v5&index=12
https://www.youtube.com/watch?v=NouyHaWGszA&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-v5&index=12
https://www.youtube.com/watch?v=jMnz7Tqoz28&index=10&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-v5
https://www.youtube.com/watch?v=jMnz7Tqoz28&index=10&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-v5
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Ressources:  

- Entretiens transcrits, P1_Act3_Entretiens.zip, dans le dossier TéléchargementProjet, 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120  

- Fiches de contact, P1_Act3_FichesContact.zip, dans le dossier TéléchargementProjet, 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120  

- Fichier P1_Act3_Codebook.xml dans le dossier TéléchargementProjet, 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120 

- Manuel Atlas-ti dans les ressources du cours (particulièrement pp. 166 et suivantes pour le 

codage de texte écrit dans Atlas) : Info_atlasti_v7_manual_201312.pdf  

- Miles, Huberman & Saldaña (2014), pp. 69-86: P1_Act3_MilesHubermanSaldana2014_pp69-

86.pdf 

Temps nécessaire: 5h 

Résultat attendu:  

Le copy bundle de l’entretien que vous avez codé, téléversé dans le dossier Moodle intitulé P1 Act 3 

Productions Etudiants : http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16111  

Evaluation:  

Evaluation formative uniquement: Feedback sur le déroulement / contenu de l’activité. 

Début d’activité : 19-10-2016 

Fin d’activité : 25-10-2016 

Lieu de l’activité : Moodle 

 

  

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16111
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Activité 4 

 

Nom de l’activité: Vérification du codage et rédaction d’une vignette 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Vérifier le codage d’un pair et passer à la rédaction du rapport de recherche. 

Objectifs d’apprentissage : 

- Etre capable de vérifier le codage d’un entretien en vue d’une analyse qualitative;  

- Etre capable d’utiliser un logiciel spécialisé de type Computer Assisted Qualitative Data 

Analysis Software (CAQDAS), en l’occurrence Atlas-ti 

- Etre capable de rédiger une vignette descriptive pour un cas. 

Motivation de l’enseignante: Poursuivre le travail d’analyse des entretiens par la vérification du 

codage et la rédaction.  

Motivation pour les étudiants: Prendre conscience de la dimension subjective du codage et de la 

nécessité de vérifier cette étape à plusieurs.  

Description de l’activité: 

Stratégie pédagogique : Analyse  

Activité collaborative :  

Vous travaillez au sein de votre groupe de deux ou trois.  

 Discutez l’actualisation du codebook (ajout, modification de définition, suppression, etc.) au 

sein de votre groupe si vous en avez éprouvé la nécessité.  

 Vérifiez le codage, au sein d’un groupe de 3 étudiants ayant codés le même entretien. 

 Rédigez un rapport de codage par groupe.  

 Rédigez une vignette par groupe, décrivant l’informateur que vous étudiez à l’aide des codes 

utilisés. La description doit être succincte et décrire les caractéristiques et l’action de 

l’informateur selon les recommandations de Miles, Huberman et Saldana, pp. 182-5. Cette 

vignette est une étape préliminaire pour vous permettre de recueillir des informations 

intéressantes lors de l’entretien que vous allez effectuer durant l’Activité 7. 

 Si vous le souhaitez, rédigez un rapport réflexif libre.  

Révision du codage effectué par unE pairE 

Pour permettre une révision du codage par les pairs, veuillez effectuer la procédure qui suit, qui sera 

effectuée par un seul étudiant par groupe. Commencez par télécharger les trois HU codés de votre 

groupe depuis le dossier Moodle P1 Act3 ProductionsEtudiants. Ensuite, enregistrez une copie de 

votre HU sous un autre nom (ex : MergeABC_Etu1). Ouvrez la HU MergeABC_Etu1 et sélectionnez 

depuis Project > Merge with HU  la HU codée par B et celle codée par C et ajustez les options comme 

montré sur la capture d’écran ci-dessous. Avec ces options, les segments codés de manière exactement 

identiques seront unifiés et un seul segment codé sera mentionné dans la marge. Les segments 
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différents, ne serait-ce que par une lettre, seront mentionnés comme différents et vous devrez 

regarder de plus près et vous mettre d’accord.  

 

1- Le nouveau fichier MergeABC _Etu1 contient les codes des trois codeurs et vous pouvez voir 

si les codes sont similaires ou différents (en mettant la souris sur la barre coloré, dans la marge, 

vous pouvez voir l’auteur de ce codage).  

2- Vous pouvez alors recourir à un logiciel qui vous servira de base pour discuter les différences 

de codage des 3 fichiers. Pour le logiciel CAT, regardez les pages 304 à 306 dans le manuel 

Atlas et/ou http://cat.ucsur.pitt.edu/app/main.aspx  

http://www.screencast.com/t/pvzmAaz2 . Vous pouvez aussi discuter les différences entre 

vous en notant le nombre de désaccords et en utilisant la formule de Miles & Huberman 

rappelée ci-dessous.  

3- Vous pourrez alors vous réunir virtuellement ou en présentiel pour discuter le codage et 

adopter, ensemble, un codage qui sera le codage définitif pour le fichier dont votre groupe est 

responsable (clic droit sur un code > delete ou changement de la sélection du segment dans le 

texte).  

4- Rapportez le taux indiqué par le logiciel et/ou utilisez la formule de Miles & Huberman (2003, 

p. 126) pour vérifier la fiabilité du codage. Cette formule est la suivante : Fiabilité = nombre 

d’accords / nombre total d’accords et de désaccords et doit amener à un pourcentage au-

dessus de 80% pour que le codage soit considéré de qualité satisfaisante.   

Outils d’analyse disponibles dans Atlas pour vous aider à comprendre le cas que vous étudiez 

Word Cruncher : c’est un outil d’analyse qui se base sur le texte de l’entretien et non sur le codage et 

qui compte simplement les mots. Vous pouvez regarder le tutoriel de 7mn pour comprendre le 

fonctionnement de cet outil : 

https://www.youtube.com/watch?v=_ft6wDluAN8&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-

v5&index=17  Vous pouvez aussi consulter le manuel Atlas, pp. 253-8. 

D’un point de vue conceptuel, que faites-vous à partir de ces décomptes de mots ? Le fait d’avoir un 

aperçu visuel des mots les plus fréquemment utilisés permet d’avoir un aperçu des sujets principaux 

abordés dans l’entretien. Comme le rapportent Mc Naught & Lam (2010), 

http://tecfalms.unige.ch/moodle/mod/resource/view.php?id=14018 , ces nuages de mots peuvent 

être utilisés à deux fins :  

- pour effectuer une analyse préliminaire, résumant rapidement les points intéressants et/ou 

des différences potentielles et indiquant, de ce fait, des pistes d’analyse ;  

- pour confirmer des interprétations ayant émergés suite à l’utilisation d’autres stratégies.  

http://cat.ucsur.pitt.edu/app/main.aspx
http://www.screencast.com/t/pvzmAaz2
https://www.youtube.com/watch?v=_ft6wDluAN8&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-v5&index=17
https://www.youtube.com/watch?v=_ft6wDluAN8&list=PL8CTEdsSSmZG7znMUsXLekGikQYrPB-v5&index=17
http://tecfalms.unige.ch/moodle/mod/resource/view.php?id=14018
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Dans notre recherche, je propose de les utiliser comme analyse préliminaire. Et ce faisant, il faudra 

être vigilant : en effet, le décompte se fait hors contexte, ce qui est un biais considérable. Pour 

reprendre l’exemple de Mc Naught & Lam, p. 641, le mot « convenient » et « not convenient » sera 

compté comme « convenient ». Pour remédier à ce biais, les auteurs ont par exemple retravaillé leurs 

textes pour transformer « not convenient » en « notconvenient ». Dans Atlas, cette manipulation peut 

être évitée par l’utilisation d’expressions régulières que l’on peut entrer dans la stoplist. Cela dit, l’unité 

d’analyse reste le mot : il n’est pas compris au niveau de la phrase et il faut rester prudent, exploiter 

cet outil comme une analyse préliminaire uniquement.  

Query Tool : C’est un outil basé sur le codage effectué préalablement. On interroge les données à l’aide 

d’opérateurs, en combinant les codes et les familles de codes.  Vous pouvez regarder le tutoriel de 

6mn de la version 6 pour comprendre le fonctionnement de l’outil. Attention, dans la version 7, le 

query tool se trouve dans le menu Analysis : https://www.youtube.com/watch?v=C11CHbuo5ME  

Vous pouvez aussi consulter le manuel Atlas, pp. 258-280. 

Comment choisir les codes et les combinaisons ? En vous basant sur vos intuitions et sur les réflexions 

consignées dans les mémos ou les notes prises durant le codage. 

Que faire à partir des résultats donnés par l’outil ? Poursuivre la piste de recherche entamée car elle a 

permis de faire ressortir des choses intéressantes ou la modifier un peu ou la laisser de côté pour 

l’instant.  

Network view : C’est un outil basé sur le codage effectué préalablement. L’outil permet de visualiser 

toutes les citations associées à un code par exemple. Pour bien comprendre comment utiliser l’outil et 

comment il fonctionne, vous pouvez regarder le webinar suivant (dès la minute 12)  : 

https://www.youtube.com/watch?v=OT3QNTH-XoA  

Vous pouvez aussi consulter le manuel Atlas, pp. 316-361 : p. 324  et suivantes pour la procédure 

technique. 

Avec cet outil, vous êtes encore plus actif qu’avec le query tool car c’est vous qui choisissez les nœuds 

et les relations. L’idée est de représenter, graphiquement, les relations entre données et concepts et 

ainsi de vous aider à comprendre ce qu’il se passe et à poursuivre votre investigation.  

Ressources:  

- Les copy bundle qui se trouvent dans le dossier Moodle ProductionsEtudiants de l’Activité 3 : 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16111  

- Miles, Huberman et Saldaña (2014), p. 162 et pp. 182-5 sur la rédaction descriptive d’une 

vignette : P1_Act4_MilesHubermanSaldana2014-pp162_182-5.pdf 

Temps nécessaire: 8h 

Résultat attendu:  

Au niveau de votre groupe,  

1) un copy bundle commun contenant les codes définitifs sur lesquels vous vous basez pour la 

rédaction, déposé dans le dossier Moodle P1 Act 4 Productions Etudiants : 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16115  

2) un rapport de vérification de codage, déposé dans le même dossier Moodle 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16115  

3) la rédaction de la vignette du cas que vous avez étudié, 600 mots maximum, déposée dans le 

même dossier Moodle : http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16115  

https://www.youtube.com/watch?v=C11CHbuo5ME
https://www.youtube.com/watch?v=OT3QNTH-XoA
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16111
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16115
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16115
http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16115
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Evaluation:  

Evaluation formative : Feedback général lors du 2e présentiel.  

Evaluation sommative : Note sur 6, au niveau du groupe, basée sur le barème disponible sur Moodle : 

http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15768   

En cas de remise en retard du travail, 1 point sera enlevé à la note finale, pour chaque semaine de 

retard.  

Début d’activité : 26-10-2016 

Fin d’activité : 08-11-2016 

Lieu de l’activité : Moodle 

 

  

http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15768
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PERIODE 2 

 

Activité 5 

 

Nom de l’activité : Familiarisation avec l’entretien 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Comprendre le cycle itératif d’une recherche qualitative en recueillant de nouvelles données.  

Objectifs d’apprentissage : 

- Etre capable de différencier plusieurs formes d’entretien et les caractéristiques de l’entretien 

phénoménographique en particulier 

- Se familiariser avec un guide d’entretien donné en vue de conduire un entretien 

Motivation de l’enseignante: A partir des données déjà analysées, prévoir un nouveau recueil de 

données pour poursuivre l’analyse déjà effectuée.  

Motivation pour les étudiants: Explorer la théorie de l’entretien phénoménographique pour se 

préparer à le conduire un peu plus tard.  

Description de l’activité: 

Activité individuelle :  

 Depuis les ressources du cours,  téléchargez l’article de Ashworth & Lucas (2000) sur la 

phénoménographie. Vous pouvez parcourir l’article de Akerlind (2005) pour comprendre 

comment les données phénoménographiques sont analysées mais l’analyse ne fera pas partie 

de ce cours.  

 Depuis les ressources du cours,  téléchargez les deux extraits de De Ketele & Roegiers 2015 sur 

l’entretien. Lisez attentivement les pages 12-14 puis les différentes pages se référant 

directement à l’entretien. Pour information, le texte a été scanné en OCR et vous pouvez 

simplement chercher « interview » pour passer d’une section à l’autre sur l’entretien. 

 Dans le dossier TéléchargementProjet, téléchargez le guide d’entretien et lisez-le. Il s’agit de 

vous l’approprier et de vous imaginer en train de l’utiliser pour conduire l’entretien.  

 Si vous le souhaitez, rédigez un rapport réflexif libre.  

Activité collaborative :  

 Réaliser une page wiki, au niveau de toute la promotion, en guise d’aide-mémoire pour ensuite 

conduire l’entretien dans les meilleures conditions.  

Ressources  

- Ashworth & Lucas (2000), P2_Act5_Ashworth_Lucas2000.pdf  
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- Akerlind (2005) : P2_Act5_InfoAnalyse_Akerlind2005.pdf => parcourir car quand on recueille 

les données, il faut aussi avoir en tête la méthode avec laquelle on va les analyser 

- De Ketele & Roegiers (2015) : P2_Act5_DeKeteleRoegiers2015-pp12-14.pdf, 

P2_Act5_DeKeteleRoegiers2015-pp117-153.pdf (uniquement les pages sur l’interview) 

- Guide d’entretien, P2_Act7_GuideEntretienPhenomeno dans le dossier TéléchargementProjet 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120  

Temps nécessaire: 5h 

Résultat attendu:  

Une compréhension des éléments principaux de l’entretien phénoménographique, rapportée de 

manière synthétique sur une page wiki pour référence ultérieure : 

http://tecfalms.unige.ch/moodle/mod/wiki/view.php?pageid=6137   

Evaluation:  

Activité Bonus : Une participation pertinente au wiki peut vous apporter entre 0.25 et 1 point bonus 

qui seront ajoutés à votre moyenne pour ce cours.  

Début d’activité : 08-11-2016 

Fin d’activité : 15-11-2016 

Lieu de l’activité : Moodle 

  

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120
http://tecfalms.unige.ch/moodle/mod/wiki/view.php?pageid=6137
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Activité 6 

 

Nom de l’activité : Préparation de la conduite d’entretien 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Tester le guide d’entretien pour se l’approprier et prendre contact avec la personne à 

interviewer. 

Objectifs d’apprentissage :  

- Etre capable, de conduire un entretien semi-dirigé en se basant sur un guide donné ;  

- Etre capable de modifier le guide d’entretien en cas de besoin. 

Motivation de l’enseignante: Se préparer au mieux pour conduire et vivre un entretien semi-structuré 

de type phénoménographique, en tant que chercheur. 

Motivation pour les étudiants: Simuler l’entretien avec un pair pour ensuite prendre contact avec 

d’autres étudiants en technologie éducative et recueillir auprès d’eux des vraies données de recherche. 

Description de l’activité: 

Activité collaborative :  

 Au sein de votre groupe de 2 ou 3, vous allez conduire l’entretien via skype (ou autre outil 

d’entente avec la personne à interviewer) 

 Pensez à l’enregistrer ! 

 Réécoutez tout ou partie de l’entretien en notant vos points forts et faibles en tant 

qu’enquêteur qualitatif utilisant l’entretien semi-directif et répétez l’exercice si vous le 

souhaitez. 

 Prenez contact avec la personne que vous allez interviewer pour 1) convenir d’une date 

d’entretien, 2) lui demander de signer le formulaire de consentement et de vous le renvoyer 

avant l’entretien.  

Activité individuelle :  

 Si vous le souhaitez, rédigez un rapport réflexif libre.  

Ressources  

- Les adresse e-mail de la personne que vous devrez contacter vous sera transmise  

individuellement 

- Formulaire de consentement signé par la personne que vous allez interviewer: le télécharger 

depuis le dossier TéléchargementProjet: 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120  

P2_Act6_FormulaireConsentement.pdf 

- Aide mémoire pour conduire un entretien, disponible depuis les ressources : 

P2_Act6_Revillard_AideMemoireEntretien.pdf 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120
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- Document Enregistrer et Transcrire disponible depuis les ressources : 

P2_Act7_EnregistrerTranscrire.pdf   

Temps nécessaire: 5h 

Résultat attendu:  

- Par groupe de 2 ou 3, le formulaire de consentement signé, téléversé dans le dossier P2 Act 6 

Productions Etudiants: http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16122  

- Par groupe de 2 ou 3 des entretiens conduits pour tester les outils (skype + guide d’entretien) 

et vos compétences d’enquêteur/rice.  

Evaluation:  

Evaluation formative : Feedback formatif sur le forum.   

Début d’activité : 22-11-2016 

Fin d’activité : 29-11-2016 

Lieu de l’activité : Moodle 

 

 

  

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16122
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Activité 7 

 

Nom de l’activité : Conduite de l’entretien et transcription 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Conduire un entretien et le transcrire.   

Objectifs d’apprentissage :  

- Etre capable de conduire un entretien ;  

- Etre capable de transcrire un entretien. 

Motivation de l’enseignante: Conduire un entretien et le transcrire pour préparer l’étape suivante 

d’analyse.  

Motivation pour les étudiants: Conduire un entretien en tant que chercheur et le transcrire pour 

mesurer l’investissement nécessaire.  

Description de l’activité: 

Activité collaborative :  

 En vous basant sur le guide d’entretien, conduisez l’entretien.  

 Renseignez la fiche de synthèse de l’entretien.  

 Transcrivez l’entretien à l’aide de Transana ou de de Dragon pour vous faciliter la tâche. 

 Si des idées d’analyse vous viennent durant la transcription, vous pouvez les ajouter sous 

forme de Commentaires dans la marge.  

Activité individuelle :  

 Si vous le souhaitez, rédigez un rapport réflexif libre.  

Ressources:  

Dans le dossier TéléchargementProjet, 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120   

- Guide d’entretien: P2_Act7_GuideEntretienPhenomeno.pdf 

- Fiche de synthèse de l’entretien: P2_Act7_FicheSyntheseEntretien.doc 

- Enregistrer et Transcrire: P2_Act7_EnregistrerTranscrire 

Dans les ressources du cours:  

- Comment transcrire: P2_Act7_Transcription_Maulini2008.pdf 

A Tecfa:  

- Les logiciels Transana et Dragon sont installés sur quelques machines Tecfa => demander à 

Stéphane 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16120
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Temps nécessaire: 7h 

Résultat attendu:  

Au niveau de votre groupe, téléversez, dans le dossier P2 Act 7 Productions Etudiants, 

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16123 :  

1) L’entretien réalisé (fichier son)  

2) Une fiche de synthèse d’entretien renseignée (fichier texte) 

3) Une transcription de l’entretien (fichier texte) 

Evaluation:  

Evaluation formative : Feedback formatif sur le forum.  

Evaluation sommative : une note sur 6 pour la conduite de l’entretien et la transcription selon le 

barème disponible sur Moodle : http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15773    

Début d’activité : 23-11-2016 

Fin d’activité : 29-11-2016 

Lieu de l’activité : Moodle 

 

  

http://tecfalms.unige.ch/moodle/mod/folder/view.php?id=16123
http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15773
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Activité 8 

 

Nom de l’activité : Réflexion sur le processus 

Enseignante: Barbara Class 

Assistante : Juliette Désiron 

Nom du cours: Introduction aux approches méthodologiques en technologie éducative 

Nom du module : Méthodologie qualitative 

Objectif: Réfléchir aux différentes étapes effectuées de l’Activité 1 à l’Activité 7 et partager son 

expérience. 

Objectifs d’apprentissage :  

- Etre capable de jeter un regard sur son apprentissage dans cette participation à une recherche 

qualitative réelle;  

- Etre capable de mesurer l’investissement nécessaire pour conduire une recherche 

qualitative et ainsi mieux pouvoir la planifier. 

Motivation de l’enseignante: Terminer le module de méthodologie qualitative en proposant une 

activité de réflexion sur l’apprentissage effectué.  

Motivation pour les étudiants: Prendre de la distance,  considérer le travail et l’apprentissage réalisés 

comme un objet externe pour se positionner quant à une recherche future de ce type.  

Description de l’activité: 

Activité individuelle :  

 Rédigez un rapport réflexif sur l’entièreté du cours de recherche qualitative (périodes 1 et 2).  

Ressources:  

-  Texte de Boud (2001) : Info_Boud2001_EcritureRapportReflexif 

Temps nécessaire: 3h 

Résultat attendu:  

1) Un rapport réflexif dans votre journal (nombre de mots libre)  

Evaluation:  

Evaluation formative : Feedback formatif sur le forum.  

Evaluation sommative : une note sur 6 pour le rapport réflexif selon le barème disponible sur Moodle : 

http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15774   

Début d’activité : 30-11-2016 

Fin d’activité : 04-12-2016 

Lieu de l’activité : Moodle 

 

http://tecfalms.unige.ch/moodle/mod/assign/view.php?id=15774

